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Rules Wizard

Using the Rules Wizard is similar to using the Filtering feature in Simeon. It allows
you to set up rules to automatically perform actions on messages meeting certain
criteria. Rules can be set to perform actions on messages arriving in your Inbox or
those that you are sending out.

Examples of rules you can create:

• Move messages to a particular folder based on who sent them or the subject
text

• Assign flags with deadlines to messages sent to you by a particular person
• Have a copy of messages that you send to a certain person automatically

sent to a particular folder
• Ask the server to automatically reply to a certain type of message by using a

message you have previously created.
• Set up a notification, e.g. message or sound, when a high importance

message arrives

Exceptions can be added to your rules for special circumstances, for example, the
rule can be set to move all messages from a certain person to a subfolder with the
exception of flagged messages which will be left in the Inbox.

Rules can be run manually or automatically. Manually means that you can apply the
rules to messages already in your Inbox.

You can also turn rules on or off and change the order in which the rules are applied.

TO CREATE A NEW RULE

1. Make sure you are in one of the e-mail folders (e.g. Inbox, Sent Items)

2. Select Rules Wizard from the Tools menu on the Outlook window and the
dialogue box shown below should appear.

3. Click the New button to start the Wizard

Existing Rules

Ticks indicate
which rules are
switched on

Description of what
the rule selected in the
upper part of the
dialogue box does
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4. The Wizard is a series of dialogue boxes which allow you to make all the
necessary choices relating to the rule you are setting up. You will usually see
at least three dialogue boxes when using the Wizard. When you have made
all the selections you require in one dialogue box, click on the Next button to
move onto the next part.

When you select an option
or options from the upper
pane you will be offered at
least one option in the lower
pane.

If you see blue underlined
words in the lower pane you
need to click on them and
make selections from
whatever choices are
offered to you. e.g. select a
person or persons from an
address book, or the name
of a subfolder.

5. In the second last dialogue box you will be offered a chance to set exceptions
to the rule so that in specific cases Outlook will ignore the rule.

6. In the final wizard dialogue box you are asked to name the rule.

If you wish to run the rule on
messages already in the Inbox,
click this checkbox

If you wish to create this rule but
are not ready to have it switched
on take the tick off this checkbox.

7. When you have entered a name for the rule and made your final selections
the Finish button will become active. Click the Finish button and you will be
taken back to the main Rules Wizard dialogue box where you will see your
new rule listed.

Typical dialogue
box from the
Rules Wizard.
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MAKING CHANGES TO RULES

You can edit, deleted, rename, switch on and off
any of the rules. To do this call up the Rules
Wizard dialogue box (Tools - Rules Wizard) and
click on the appropriate buttons or add and
remove ticks from check boxes

You may also reorder the rules in this dialogue
box by selecting the rule and clicking the Move
Up or Move Down buttons. The rules will now
run in the new order. This may be critical if some
messages meet the criteria of more than one
rule.

Using Find

Once you have many messages built up in your folders you may sometimes find
locating a specific message quite a difficult task. The Find button allows you to filter
for messages with specific words or phrases in the subject line or message text. The
Advanced Find feature allows you additionally specify other criteria for the find,
such as who the message was sent from or when it was sent.

USING THE FIND BUTTON

1. Open the folder or subfolder you wish to search. (The basic find feature can
only search one folder at a time)

2. Click the Find button on the Outlook window toolbar and the following Find
pane will appear just above the message headers.

3. Type in the word,
partial word or phrase
you wish to search for
in the Look For: box.

NOTE:
If you wish Outlook to search just through the subject line text and not the
message text as well you need to remove the tick from this checkbox.

4. Click the Find Now button.
This will start the search and
all the messages containing
the words or phrases you
specified will be listed below
the Find pane.

Results of
search
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TO SHOW ALL THE MESSAGES

If you wish to clear the find results and bring back all the messages click on the
Clear Search option at the bottom of the Find pane.

USING ADVANCED FIND TO NARROW A SEARCH OR SEARCH MORE THAN ONE FOLDER

Advanced Find can be used to narrow your search, set up a more complex filter or to
search more than one folder

1. Click the Advanced Find option at the top right corner of the Find pane or the
Go to Advanced Find option near the bottom of the Find pane. This will call
up the Advanced Find dialogue box.

2. Specify the criteria you require, e.g. from, sent to, time when sent, type in
words you wish to search for and specify where you wish to search.

3. Click the Find Now button to run the search. The results of your search
appear under the Advanced Find dialogue box.

4. To close the Advanced Find dialogue box click on the X close button and you
are taken to the Find pane. You may either close down the Find pane or Clear
the search.

TIP
The Advanced Find dialogue box has two tabs which are worth exploring as they
offer even more choices for your search

    More Choices tab  Advanced tab

Type in name of
person or click From
and select from
address book

Select time received
or sent and specify
length of time such
as today or within
last week

NOTE:
You may be very specific
about which folders and
subfolders are to be
searched. The default is
for Mailbox to be selected
which means that it will
search all your mailbox
folders. If you click on the
Browse button you can
select which folders and
subfolders you wish to
search.
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Voting Buttons

You may wish to have a group of people vote on their preferred choice from a
selection of choices offered to them. It is possible for you to send out a message to
the group of people which contains a button for each choice you have to offer. Each
recipient votes by clicking on the button representing their choice. As the responses
come in Outlook will track and calculate the results.

NOTE:
This feature will only work with users on the same Exchange Server, i.e. only
Institute members of staff using Outlook.

TO CREATE A MESSAGE WITH VOTING BUTTONS

1. Start a new message and put your question in the Subject field.

2. Click on the Options button on the message window toolbar to bring up the
Message Options dialogue box.

3. Mark the check box
Use voting buttons:

4. make sure the
Save sent message to:
is marked (essential if
you wish to track the
results)

5. Either
• select from any set of voting choices from the drop down list, where

you can select groups of choices such as:
Yes; No,   or  Approve; Reject

• type your own list of choices into the box, separating each with a
semicolon

6. Click the Close button and complete and send the message

TO VOTE WHEN YOU RECEIVE A VOTINGMESSAGE

1. The question for the
vote will usually be in
the subject field. Open
the message and the
instructions will be
placed in the yellow
banner.

2. To send in your vote
click on the button of
your choice
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NOTE:
It is sometimes difficult to see all the buttons as the formatting toolbar
may have been set to be on a separate row from the standard toolbar.
If this is so only the first one or two button will be visible, all the rest will
be hidden behind the formatting toolbar. To view all the buttons click on
the vertical bar at the beginning of the format bar and drag right to
expose all the buttons

3. You will be asked if you wish to send the
response now or take the opportunity to
edit the message before sending in the
vote. If you choose to edit you will be able
to add more text into the body of the
message or add/remove people from the
To or Cc boxes.

VIEWING THE VOTING RESPONSES

Every time someone votes you will receive a message from that person in your
Inbox. On the message header the subject text will be prefixed by the senders’
choice.

If you open the message the voter’s choice will appear in the yellow banner at the
top of the message window

TRACKING THE VOTING RESPONSES

If you have saved a copy of the original message to your Sent Items folder you will
be able to track the responses.

1. Locate the copy of the original message and open it.
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2. Click on the Tracking tab

Summary of results showing
most popular choice first

List of all users who received your
original message

Results for each individual
appear here as they come in

Setting Options for Outgoing Messages

There are various options you can set before sending out individual messages. This
section looks at the following options: importance, sensitivity, delivery and read
receipts, setting message expiry times and delaying sending messages.

All these options can be set
from the Message Options
dialogue box shown opposite.
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Importance/Sensitivity
Importance and sensitivity can be set to indicate to the recipient how they should
treat the message. For example, one of the options under Sensitivity, such as
Personal or Confidential, can be set to indicate to the recipient that the message is
not for publication. When the recipient receives the message the importance and
sensitivity status will be listed on a yellow banner at the top of the opened message
window.

TO SET THE IMPORTANCE OF SENSITIVITY STATUS

1. Start a new message and click on the Options button on the message
window toolbar to bring up the Message Options dialogue box.

2. Click the down arrow by the Importance or Sensitivity
boxes and select the option you require.

3. Click the Close button

NOTE:
When Private status is applied to a message the recipient will not be able to edit any
of the text.

Delivery and Read Receipts

It is sometimes useful to request delivery or read receipts. Receipts can be
requested for each individual message that is sent or can be programmed to be
automatically sent whenever you send a message.

NOTE:
The receipt features work very well when e-mailing other people at the Institute but
they are not always successful when e-mailing people outside the Institute.

TO REQUEST DELIVERY OR READ RECEIPTS FOR AN INDIVIDUAL MESSAGE

1. Start a new message and click on the Options button on the message
window toolbar to bring up the Message Options dialogue box.

2. Tick the check box(es) for the option(s) you require and click the Close button
Request a delivery receipt for this message
Request a read receipt for this message

TO REQUEST DELIVERY OR READ RECEIPTS FOR ALL MESSAGES SENT

1. Select Options from the Tools menu on the Outlook window

2. Click the Preferences tab

3. Click E-mail Options, and then click Tracking Options
4. Select the check box(s) you require and click the Close button

Request a delivery receipt for all messages I send
Request a delivery receipt for all messages I send
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RECEIPTS ARRIVING IN YOUR INBOX

Read receipts

• will arrive in your Inbox and appear to have been sent from the
recipient.

• the subject title will be prefixed by Read:
• the icon will contain a green tick

Delivery receipts

• will arrive in your Inbox and appear to have been sent from the System
Administrator.

• the subject titles will be prefixed Delivered:
• the icon will contain a green forward arrow

Receipts from Outside Institute
Read and delivery receipts may or may not work with outside Institute users
as it depends upon their system and how it is set up.

The results of a delivery and read receipt test to an outside Institute user is
shown below. Note that the icon for the delivery receipts is different and a
read receipt failed to arrive.

CONTENTS OF A RECEIPT

When you open a receipt you will
find information about who
received delivery of or read your
message and at what time.

Delay Message Delivery

You may wish to delay sending a message until a specific date and time, maybe
because you think you may forget to send it later.
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TO DELAY MESSAGE DELIVERY

1. Start a new message and click on the Options button on the message
window toolbar to bring up the Message Options dialogue box.

2. Mark the Do not deliver before:
check box and then set the date by
clicking on the down arrow and
selecting a date from the drop down
calendar which appears. Amend the
time to the exact time you require.

TIP:
You could type in the date or
something like week from Fri
and the AutoDate feature will
select the correct date

3. Click on the Close button

READING DELAYED MESSAGES

When the recipient opens the message they will see a yellow banner at the top of the
message window with details of the delayed settings:

NOTE:
This feature will only work if you leave your computer turned on and Outlook opened
at the time delivery is due.

Setting Message Expiry Times
You may wish to set a message you are sending out to expire on a certain date and
time if it will become irrelevant by then. For example, you may want to e-mail your
department to say that there are left-over cakes and sandwich from a meeting and
set the expiry to later that day. This will mean that anyone not in that day will not
waste time reading the message only to find that the message is now irrelevant
when they come into work the next day.

TO SET AN EXPIRY DATE FOR A MESSAGE

1. Start a new message and click on the Options button on the message
window toolbar to bring up the Message Options dialogue box.

2. Mark the Expiry After: check box and
then set the expiry date by clicking on
the down arrow and selecting a date
from the drop down calendar which
appears. Amend the time to the exact
time you require.

3. Click on the Close button
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MESSAGE AFTER EXPIRY

When a message reaches its expiry date it is either removed from your Inbox or the
message header will change its appearance - grey colour text and have a line
through it as shown below. What happens depends upon whether the message was
opened by the recipient or not.

If you open a message which has the appearance as shown above you will see a
yellow banner with the expiry details.

NOTE:
You may find that messages are not expiring at the exact times you have set. This is
because the expiry setting is not looking at your computer’s clock but the clock on a
server.

NOTE:
If you wish to set an expiry date for a message you have already received right click
on the message header, select Options, tick the Expiry After check box and set the
expiry date as above.

Diverting Incoming Replies to Another User
You may have sent out a message to a group of people requesting some information
but wish all the replies to go to one of your colleagues who have agreed to process
all the information. It may be that your team requires an urgent response to the
message but you will not be at work to process the replies and wish to make sure the
response will go to someone else in your team.

TO DIVERT INCOMING REPLIES

1. Start a new message and click on the Options button on the message
window toolbar to bring up the Message Options dialogue box.

2. Mark the check box Have replies Sent To:

3. Either type the e-mail address of the person you wish to direct relies to or click
on the Select Names button and select from the address books.

TIP:
If you add your name to the list you will have a record of all the replies
that arrived in your absence

4. Click OK and complete the message.
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Resending and Recalling Messages

You may sometimes need to resend a message for reasons such as the recipient’s
server was down and the original message was lost, another user needs to see a
copy of the message you sent or you may have sent the message to an incorrect
address. Outlook allows you to resend a message without having to recreate it.
When you resend you have the chance to make any edits to the message text, add
attachments or change the recipient names.

You may wish to recall a message if you have changed your mind about sending it or
maybe you forgot to add the attachment before sending it. Outlook is able to recall a
message only if the recipient has not yet opened it.

NOTE:
These features are only possible if you have saved a copy to the Sent Items folder
or another appropriate folder.

TO RESEND A MESSAGE

1. Open the copy of the message you wish to resend in your Sent Items folder,
or whichever subfolder you sent the copy to

2. Carry out any changes required

3. From Actions on the message window menu bar select Resend This
Message. This will create a copy of the message. Make any changes that are
necessary

4. Click the Send button on the copy of the message

TO RECALL A MESSAGE

1. Open the copy of the message you wish to resend in your Sent Items folder,
or whichever subfolder you sent the copy to.

2. From Actions on the message window menu bar select Recall This
Message. The following dialogue box will appear

3. Mark your choices and click OK



MESSAGES REPORTING SUCCESS OF RECALL

If you switched on the option to be told whether recall was successful or not you will
receive a message in your Inbox which will tell you the result of the recall for each
recipient.

If you open the
and time the m

Tips and T

This section c

Copy Multip
When you are
clipboard. You
all the items to

TO COPY MULT

1. Select t

2. Select t
button o

3. Select a

Blue arrows = Success
Red Cross = Failure

Subject text prefixed with the recall report

Cop

Two ic
items 
Recipient name
se messages you will see a report with all details such as the date
essage was recalled.

ricks

overs various short tips and tricks which you may find useful.

le Items onto Outlook’s clipboard
 in Outlook you may copy or up to 12 separate items onto the
 may then paste the items separately into another messages or paste
gether.

IPLE ITEMS TO THE CLIPBOARD

he first item you want to copy e.g. some text from a received message.

he Copy command in the usual way (Edit - Copy, CTR+C, or Copy
n the standard toolbar)

nother item and use the Copy command again.
Unlike other packages, such as Word97, Outlook will be able to place
the second item onto its clipboard. At this stage the following toolbar
appears.
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y button Paste All button

Clear All button

ons show that two
are on the clipboard
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TIP
To call up the clipboard at any time if you wish to view it, select
Toolbars from the View menu on the new message and then Clipboard.

4. Once the Clipboard toolbar is in view you can use the Copy button on it to
copy further items onto the clipboard.

The maximum number of items you
can store on the clipboard is twelve. In
order to identify what each icon is
hover your mouse over each icon and
the first few words of any copied or cut
text will be shown like in the example
opposite.

NOTE:
If you try to copy or
cut more than twelve
items you will get the
following dialogue
box.

Decide if you wish to have the first item replaced by the new item. If you are happy
for this to happen you may click OK.

TO PASTE SEPARATE ITEMS

1. Position the I beam where you wish the item or text to be pasted.

2. Click on the appropriate icon on the clipboard representing the item you
require

TO PASTE ALL ITEMS

1. Position the I beam where you wish all the items to be pasted.

2. Click on the Paste All button on the clipboard toolbar

TO CLEAR THE CLIPBOARD

It is not possible to remove single items from the clipboard. The only option you have
is to clear the clipboard of all items. To do this click on the Clear All button on the
clipboard toolbar.



Customising Fields

You may wish to add or remove fields displayed above your message headers. One
field which you may find useful is the message size field. To display this or any other
field:

1. Right-click on any displayed field, such as From:, Subject

2. Select Customize Current View
3. Click on the Fields button and the Show Fields dialogue box should appear

4. Select any field you
require from the list on the
left, and then click the
Add button to add it to the
list on the right

5. When you have added all
the fields you require click
OK, and OK again.

TIP
You may wish to change the order of the fields by clicking on the Move
Up or Move Down buttons. This determines the order the fields will be
listed in.

Orga
You c
stand 
to whi
messa
messa

Size field now displayed

TIP
You may rearrange the order of the
fields by clicking on the field name
you wish to move and hold the
mouse button down. Then drag the
field horizontally to another position
and let go of the mouse button
TIP
If you wish to resize the width of any
field point your mouse over the
border between two fields. When a
virtical line appears with two
horizontal arrows click and drag to
the desired size.
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nising Your Message Headers with Colours
an set up Outlook to apply colours to certain message headers to make them
out visually in your list. You need to select which colour you wish to apply and
ch group of message headers, e.g. apply purple to all message headers for
ges sent to you by a particular person. I find it useful to apply a colour to all
ges arriving in my Inbox from myself.
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Note:
It is not possible to apply a colour to a selected individual message header.

TO APPLY COLOUR TO ALL MESSAGES FROM THE SAME PERSON:

1. Open the Outlook folder which contains the messages you wish to colour
2. Either click on the Organize button on the toolbar or select Organize from the

Tools menu to call up the following Organize pane
3. Click on the Using

Colours option
4. Decide which group

of messages you wish
to apply a colour to,
ie. any messages
from a particular
person.
Now click on a message header for a message you have received from that
person and their name will appear in the appropriate box.

5. Select one of the 16 colours from the box on the right by clicking on the down
arrow and clicking on your choice of colour

6. Click the Apply Colour button
Now all the messages from the selected person are recoloured, and all new
messages you receive from that person will also be recoloured.

7. Click on the X control button to close the Organize pane.

OPTIONS WITH AUTOMATIC FORMATTING

If you wish to be more specific about which messages are recoloured you need to
use Automatic Formatting.

1. Follow steps 1 - 3 in the above section
2. Click on the Automatic Formatting option at the top right hand corner of the

Organize pane and the Automatic Formatting dialogue box appears
3. Click on the Add button and an untitled

rule will be added to the list
4. Type in a name for the rule
5. Click on the Font button and then select

the various font attributes you require
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6. Click on the Condition button and the Filter dialogue box will appear. Make
your selections from the numerous choices and click OK.

NOTE:
There are two tabs with
further choices.

NOTE:
This dialogue box is very
similar to the Advanced Find
dialogue box

Editing Subject Text on Message Headers
Have you ever wished you could change the subject text on a message to make it
easier for you to locate it in the future? With Outlook you are able to switch on ‘allow
in cell editing’ and this lets you edit just the subject text but not the date received or
from text.

1. Right click on any field heading
2. Select Customise Current View
3. Click on the Other Settings Button and

the dialogue box shown opposite will
appear.

4. Put a tick inside the ‘Allow in-cell
editing’ checkbox.

Turning on the Automatic Spelling Checker
When the automatic spelling checker is switched on the spelling checker will be
activated automatically whenever you click on the Send button.

1. Select Options from the Tools menu on the Outlook window
2. Click on the Spelling tab
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3. Put a tick in the Always Check
Spelling Before Sending check box
and have a look at all the other
options which allow you to customise
the spelling checker

4. Click OK

WHEN SENDING MESSAGES

Now when you type a new message
and click on the Send button, if there
are any spelling mistakes in the text the
spelling checker will stop at the first
incorrectly spelt word and the following
dialogue box will appear:

This spelling checker works very much
like any other spelling checker

TIP:
You may find the spelling checker frustrating to use at first for it will identify names
you type in your message text as spelling mistakes. You can add them to your
Outlook dictionary by clicking on the Add button in the dialogue box shown above
when the name is identified as incorrectly spelt, or you may wish to edit the
dictionary and put in many names in one go.

TO EDIT DICTIONARY

1. Select Options from the Tools menu on the outlook window
2. Click on the Spelling tab
3. Click on the Edit Button and a note pad file

will appear similar to the one shown
opposite.

Notice that there are already some entries
in this file, such as numbers, your names
and e-mail address.

4. You need to type in all the words you do not
wish the spelling checker to pick up as
incorrectly spelt words. E.g. names,
abbreviations, terminology.
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5. When you have finished typing close the
notepad file and say Yes when asked if
you wish to save the changes:

TIP:
If you wish to see red wavy lines appear under all incorrectly spelt words as you type
you should set up Microsoft Word to be your text editor (see the Outlook Intermediate
- Part 1 handout)

Sending a Document as an Attachment from Microsoft Word
If you have just typed something in Word and wish to send it to someone as an
attachment, you can do it directly from Word without having to go into Outlook

1. Open Microsoft Word and type the document or open and an existing Word
document which you wish to send

2. Select Sent To from the File menu

3. Select Mail Recipient
4. A dialogue box appears like the one shown

opposite.

Address the new message window or Click on
the To: button to access the Global Address
book or your Contacts.

5. Click on Send button

Printing Multiple Messages to Run Continuously on Paper
If you need to print several e-mail messages and are happy for them to run on one
after the other (and save on paper).

1. Open the folder where the messages you wish to print are located
2. Use Shift Click or Control Click to select more than one message
3. Click the Print button on the toolbar

Attachments using Drag and Drop
Another way to attach a file to a message is to locate the file in My Computer or
Explorer, click on it and hold the mouse button down, then drag and drop it over a
new message window. A copy of the file is now attached to the message. To make
this work you will need to resize and reposition the Outlook Window so you can see
both the new message window and the file at the same time.

The current  Word document
is now an attachment on this
message window
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